
Oracle� Support

Concepts and Procedures

Release 11i

February 2002

Part No. A97211-01



Oracle Support Concepts and Procedures, Release 11i

Part No. A97211-01

Copyright © 2001, 2002 Oracle Corporation. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information of
Oracle Corporation; they are provided under a license agreement containing restrictions on use and
disclosure and are also protected by copyright, patent, and other intellectual and industrial property
laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required
to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems
in the documentation, please report them to us in writing. Oracle Corporation does not warrant that this
document is error free. Except as may be expressly permitted in your license agreement for these
Programs, no part of these Programs may be reproduced or transmitted in any form or by any means,
electronic or mechanical, for any purpose, without the express written permission of Oracle Corporation.

If the Programs are delivered to the U.S. Government or anyone licensing or using the programs on
behalf of the U.S. Government, the following notice is applicable:

Restricted Rights Notice Programs delivered subject to the DOD FAR Supplement are "commercial
computer software" and use, duplication, and disclosure of the Programs, including documentation,
shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement.
Otherwise, Programs delivered subject to the Federal Acquisition Regulations are "restricted computer
software" and use, duplication, and disclosure of the Programs shall be subject to the restrictions in FAR
52.227-19, Commercial Computer Software - Restricted Rights (June, 1987). Oracle Corporation, 500
Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup,
redundancy, and other measures to ensure the safe use of such applications if the Programs are used for
such purposes, and Oracle Corporation disclaims liability for any damages caused by such use of the
Programs.

Oracle is a registered trademark of Oracle Corporation. Other names may be trademarks of their
respective owners.



Contents

Send Us Your Comments .................................................................................................................. vii

Preface............................................................................................................................................................ ix

Audience for This Guide ...................................................................................................................... ix
How To Use This Guide ....................................................................................................................... ix
Documentation Accessibility ................................................................................................................ x
Other Information Sources .................................................................................................................... x
Do Not Use Database Tools to Modify Oracle Applications Data ................................................ xv
About Oracle ........................................................................................................................................ xvi

1 Understanding Oracle Support

1.1 Overview of Oracle Support................................................................................................ 1-1
1.2 Integration with Other Oracle Products ............................................................................ 1-2
1.2.1 CRM Foundation............................................................................................................ 1-2
1.2.2 Charges ............................................................................................................................ 1-4
1.2.3 Contracts.......................................................................................................................... 1-4
1.2.4 Counters .......................................................................................................................... 1-4
1.2.5 Customer Care................................................................................................................ 1-4
1.2.6 Field Service .................................................................................................................... 1-5
1.2.7 Human Resources (HRMS)........................................................................................... 1-5
1.2.8 Install Base....................................................................................................................... 1-5
1.2.9 iSupport ........................................................................................................................... 1-5
1.2.10 Knowledge Management .............................................................................................. 1-5
1.2.11 Quality ............................................................................................................................. 1-6
iii



1.2.12 Quality Online ................................................................................................................ 1-6
1.2.13 Scripting........................................................................................................................... 1-6
1.2.14 Telephony Manager ....................................................................................................... 1-6
1.2.15 Universal Work Queue.................................................................................................. 1-6
1.2.16 Workflow......................................................................................................................... 1-7
1.3 Key Features ........................................................................................................................... 1-7
1.4 Oracle Support Business Flow............................................................................................. 1-8

2 Managing Service Requests

2.1 Overview of Creating a Service Request............................................................................ 2-2
2.2 Accessing the Service Requests Window........................................................................... 2-5
2.3 Finding an Existing Service Request................................................................................... 2-8
2.4 Accessing Customer Information...................................................................................... 2-12
2.4.1 Accessing Customer Information Using Contact and Customer Type ................ 2-12
2.4.2 Accessing Customer Information Using Additional Entry Points........................ 2-13
2.5 Viewing the Customer Profile ........................................................................................... 2-14
2.6 Verifying Product Coverage .............................................................................................. 2-16
2.7 Creating and Viewing Notes.............................................................................................. 2-19
2.8 Searching the Knowledge Base.......................................................................................... 2-21
2.9 Viewing the Service Request Log...................................................................................... 2-22
2.10 Managing Service Request Contacts................................................................................. 2-24
2.11 Managing Service Request Customer Addresses ........................................................... 2-26
2.12 Managing Tasks ................................................................................................................... 2-29
2.12.1 Creating a Task Manually ........................................................................................... 2-30
2.12.2 Creating a Task Using the Task Template ................................................................ 2-31
2.12.3 Entering Task Details ................................................................................................... 2-32
2.12.4 Task Default Fields....................................................................................................... 2-35
2.13 Viewing Customer Interactions and Activities ............................................................... 2-35
2.14 Linking Related Documents to a Service Request .......................................................... 2-36
2.15 Viewing Service History..................................................................................................... 2-38
2.16 Printing a Service Request.................................................................................................. 2-39
2.17 Wrapping Up a Call ............................................................................................................ 2-39
2.18 Contributing to the Knowledge Base................................................................................ 2-42
2.19 Closing a Service Request................................................................................................... 2-42
2.20 Service Request Workflows................................................................................................ 2-43
iv



2.20.1 Service Request Workflow Attributes....................................................................... 2-44
2.20.2 Seeded ’Call Support’ Workflow Process ................................................................. 2-45
2.20.3 Notify Owner Subprocess ........................................................................................... 2-47
2.20.4 Escalate Notification Subprocess ............................................................................... 2-48
2.20.5 Alert Supervisor Subprocess ...................................................................................... 2-49

3 Using the Service Requests Tools Menu

3.1 Entering Quality Results ...................................................................................................... 3-2
3.2 Sending a Copy of the Service Request Using Fulfillment.............................................. 3-2
3.3 Printing a Service Request ................................................................................................... 3-3
3.4 Copying a Service Request................................................................................................... 3-4
3.5 Managing Workflows ........................................................................................................... 3-5
3.5.1 Manually Using Service Request Workflows............................................................. 3-6
3.5.2 Using Service Request Task Workflows ..................................................................... 3-7
3.6 Viewing Service Request Audit History ............................................................................ 3-7
3.7 Creating a Defect from Service Requests ........................................................................... 3-8
3.8 Creating an Enhancement from Service Requests............................................................ 3-9
3.9 Managing Messages in Service Request........................................................................... 3-10
3.9.1 Sending Messages ........................................................................................................ 3-10
3.9.2 Viewing and Responding to Messages ..................................................................... 3-11
3.9.3 Viewing Message History ........................................................................................... 3-12
3.10 Recording Counter Readings............................................................................................. 3-13
3.11 Billing for Charges from Service Requests ...................................................................... 3-14
3.12 Escalating a Service Request .............................................................................................. 3-14
3.13 Escalating a Service Request Task..................................................................................... 3-17
3.14 Navigating Using Quick Menu ......................................................................................... 3-18
v



vi



Send Us Your Comments

Oracle Support Concepts and Procedures, Release 11i

Part No. A97211-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this
document. Your input is an important part of the information used for revision.

� Did you find any errors?
� Is the information clearly presented?
� Do you need more information? If so, where?
� Are the examples correct? Do you need more examples?
� What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document
title and part number, and the chapter, section, and page number (if available). You can send com-
ments to us in the following way:

Oracle Corporation
CRM Content Development Manager
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

If you would like a reply, please give your name, address, telephone number, and (optionally) elec-
tronic mail address.

If you have problems with the software, please contact your local Oracle Support Services.
vii



viii



Preface

Audience for This Guide
Welcome to Release 11i of Oracle Support Concepts and Procedures.

This guide assumes you have a working knowledge of the following:

� The principles and customary practices of your business area.

� Oracle Support

If you have never used Oracle Support, Oracle suggests you attend one or more
of the Oracle Support training classes available through Oracle University.

� The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications
product information.

How To Use This Guide
This document contains the information you need to understand and use Oracle
Support.

� Chapter 1 provides overviews of the application and its components,
explanations of key concepts, features, and functions.

� Chapter 2 provides process-oriented, task-based procedures for using Oracle
Support service requests to perform essential business tasks.

� Chapter 3 provides process-oriented, task-based procedures for using the tools
menu that is available from the Service Requests window.
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Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples
in this document. The conventions for writing code require that closing braces
should appear on an otherwise empty line; however, JAWS may not always read a
line of text that consists solely of a bracket or brace.

Other Information Sources
You can choose from many sources of information, including online
documentation, training, and support services, to increase your knowledge and
understanding of Oracle Support.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online
help patches are available on MetaLink.

Related Documentation
Oracle Support shares business and setup information with other Oracle
Applications products. Therefore, you may want to refer to other product
documentation when you set up and use Oracle Support.

You can read the documents online by choosing Library from the expandable menu
on your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.
x



If you require printed guides, you can purchase them from the Oracle Store at
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using
the graphical user interface (GUI) available with this release of Oracle Support (and
any other Oracle Applications products). This guide also includes information on
setting user profiles, as well as running and reviewing reports and concurrent
processes.

You can access this user’s guide online by choosing ”Getting Started with Oracle
Applications” from any Oracle Applications help file.

Documents Related to This Product

Oracle Support Implementation Guide
This guide provides information required for implementing and setting up Oracle
Support.

Oracle Customer Care Concepts and Procedures
This guide describes how to use Oracle Customer Care. Oracle Customer Care
provides the functionality for using the Contact Center, Relationship Plans and
tracking critical customers.

Oracle Customer Care Implementation Guide
This guide provides information required for implementing and setting up Oracle
Customer Care.

Oracle Service Implementation Guide
This guide describes how to implement and setup Oracle Service. Oracle Service
provides the functionality required for Counters and Charges.

Oracle Service Concepts and Procedures
This guide describes how to use Oracle Service. Oracle Service provides the
functionality required for Counters and Charges.
xi



Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle Applications. This guide
also introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle
Applications products. In Release 11i, much of the installation process is handled
using Oracle Rapid Install, which minimizes the time to install Oracle Applications,
the Oracle8 technology stack, and the Oracle8i Server technology stack by
automating many of the required steps. This guide contains instructions for using
Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the
CRM products. The steps should be done immediately following the tasks given in
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i.
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade,
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information that you need to
run the AD utilities. This guide also provides information on maintaining the
Oracle applications file system and database.
xii



Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle
Applications development staff. It describes the UI for the Oracle Applications
products and how to apply this UI to the design of an application built by using
Oracle Forms.

Other Implementation Documentation

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as
customize existing Oracle Applications-embedded workflow processes.You also use
this guide to complete the setup steps necessary for any Oracle Applications
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the
Oracle Enterprise Installed Base implementation team, as well as for users
responsible for the ongoing maintenance of Oracle Applications product data. This
manual also provides information on creating custom reports on flexfields data.
xiii



Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific
Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
eTRM is available on Metalink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Enterprise
Installed Base and reach full productivity quickly. You have a choice of educational
environments. You can attend courses offered by Oracle University at any one of
our many Education Centers, you can arrange for our trainers to teach at your
facility, or you can use Oracle Learning Network (OLN), Oracle University's online
education utility. In addition, Oracle training professionals can tailor standard
courses or develop custom courses to meet your needs. For example, you may want
to use your organization’s structure, terminology, and data as examples in a
customized training session delivered at your own facility.
xiv



Support
From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Enterprise Installed
Base working for you. This team includes your Technical Representative, Account
Manager, and Oracle’s large staff of consultants and support specialists with
expertise in your business area, managing an Oracle8i server, and your hardware
and software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain
information and advice from technical libraries and forums, download patches,
download the latest documentation, look at bug details, and create or update TARs.
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
Technical Libraries/ERP Applications/Applications Installation and
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.
xv



When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160
software modules for financial management, supply chain management,
manufacturing, project systems, human resources and customer relationship
management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.
xvi



Understanding Oracle Su
1

Understanding Oracle Support

This chapter provides overviews of the application and its components,
explanations of key concepts, features, and functions, as well as the application’s
relationships to other Oracle applications.

The following topics are covered:

� Overview of Oracle Support

� Integration with Other Oracle Products

� Key Features

1.1 Overview of Oracle Support
Customers contact your support organization via phone, e-mail, or the web when
they experience difficulties using or understanding the product, or with the way
the product functions. In response, a support agent creates a service request, or if
there is a self service support application, the customer logs a service request
himself.

Oracle Support allows an organization to manage customer requests for service
assistance. A service request is a report of a specific problem that requires support
assistance to resolve. The Service Request module is integrated with a powerful
Knowledge Management module so that you can leverage existing knowledge
within the organization and build your solutions knowledge base by channeling
information you collect while responding to service requests.

Oracle Support categorizes each customer request for service into user-definable
service request types such as product complaints, field failures, and product
inquiries. Service requests are not limited to functioning customer products, since
you can log requests for non-product issues such as clarification of documentation,
resolution of implementation issues, and product upgrade information.
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Integration with Other Oracle Products
Additional customization capability is provided by allowing the Service Request
type to be mapped to the user responsibility. The mapping of a service request type
to a responsibility also allows for other applications that use service requests to
display request types that are relevant to the request context.

While logging service requests, you can assign an urgency and severity status for
each request. An urgency reflects the service request from the caller’s view of the
event, while the severity reflects the support agent’s interpretation of the event.
Setting these attributes allows a timely resolution for each service request.

In the service request setup forms, you can fully define your service requests by
Type, Status, Urgency, Severity, Problem, and Resolution codes. Rather than
displaying all possible problem codes available, Oracle Support restricts these codes
based on Item and an Incident type. Each code serves to refine the service request
definition and aids in problem trend analysis and resolution.

1.2 Integration with Other Oracle Products
Oracle Support manages the business processes involved in the cycle of providing
customer support. It is integrated with a number of Oracle applications.

1.2.1 CRM Foundation
Oracle CRM Foundation is a set of application components that can be used by all
CRM modules. A description of how Oracle Support uses the CRM Foundation
applications follows.

1.2.1.1 Resource Manager
Resource Manager is a single repository for defining teams and groups of people or
any other type of resources such as equipment and venues. Oracle Support uses
Resource Manager for assigning service request tasks to people.

1.2.1.2 Tasks
In Oracle Support, tasks are created to assign work that is related to service
requests. Service requests can have an unlimited number of tasks to represent what
has been done or has been scheduled to be done to resolve the service request.
For each task, you can specify an owner and multiple assignees, a status, a task
type, start and end dates and times, and free-form text describing the task.
Additionally, you can use task type as a parameter to route tasks through a
separate workflow-based resolution process analogous to the workflow process
used for service requests.
1-2 Oracle Support Concepts and Procedures



Integration with Other Oracle Products
1.2.1.3 Assignment Manager
Assignment Manager can determine the best resource to be assigned to service
requests and tasks based on territories, availability and skill set. Oracle Support
uses this engine to assign unassigned tasks and service requests to a resource or a
group of people. In this release of Oracle Support the Assignment Manager
integration is enhanced so that the assignment of a service request to a group or
individual owner is automatic, and based on a pre-defined qualifier in the
Assignment Manager. Additionally, an Assignment Manager option at the
Individual Owner level is now used to qualify the pool of resources within the
associated group. The Assignment Manager can be run at user-specified intervals to
identify and assign unassigned service requests and tasks.

1.2.1.4 Territory Manager
Territory Manager provides an infrastructure to define territories based on
flexible criteria, such as geography, zip code, area code, etc. Assignment Manager
uses territories during the assignment process.

1.2.1.5 1-to-1 Fulfillment
This engine is designed to support high volume electronic fulfillment of
documents. Oracle Support uses 1-to-1 Fulfillment to provide copies of service
requests to customers via email or fax.

1.2.1.6 Escalation Manager or Business Rule Monitor
This engine provides the workflow capabilities for all CRM modules to model
business rules, monitor the completion of tasks, and escalate automatically when a
business rule is violated. Through a Graphical User Interface users can create
exception conditions, which result in automatic escalations. Users can also choose to
escalate tasks or service requests manually on a case by case basis. Oracle Support
uses Escalation Manager to ensure that service level agreements are met.

1.2.1.7 Interaction History
This module provides the CRM suite with a common framework for capturing and
accessing all interaction data associated with customer contacts. You can record
all customer interactions for each service request by logging all incoming and
outgoing calls and details associated to the calls.
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Integration with Other Oracle Products
1.2.1.8 Notes
The Notes infrastructure enables the entire CRM suite to create, maintain and
share notes related to customers, opportunities, service requests and other business
objects. Oracle Support uses notes in service requests to document service request
activity and to search and contribute to the knowledge base.

1.2.2 Charges
Using the Charges capability, a service organization can bill customers for services
provided in response to support service requests, field service requests or depot
repairs. Charges also provide the functionality of creating a Return Material
Authorization (RMA) to return a defective product for repair, loaner or
replacement. Charges created for a service request are processed by Oracle Order
Management and Oracle Receivables.

1.2.3 Contracts
Contract information describes those services to which a customer is entitled.
Integration with Oracle Contracts allows service entitlement, discount
calculation and response time calculation during the logging of a service
request.

1.2.4 Counters
From within service requests you can update any Counters associated with a
specified product, installed base item or product. An example of a usage for
counters is a service contract for a copy machine where the contract charges
depend on the number of copies that have been generated.

1.2.5 Customer Care
Customer Care provides the ability to manipulate customer data, track critical
customers and relationship plans.

The integration of Oracle Support with the Customer Profile feature of Oracle
Customer Care enables the support agent to make intelligent decisions as to the
provision of support to customers. The profile contains summarized customer
information and can be used to drive workflow designed to deliver superior
customer service.
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Customer information is entered in the Customer Care Contact Center and can be
viewed from the Service Requests window. The Contact Center can be accessed
from the Service Requests window by clicking the Customer button.

1.2.6 Field Service
Oracle Field Service functionality manages the servicing of products at
customer sites. While resolving a service request, you can log all labor, material, and
expenses incurred in processing the service request using the Field Service
Report. These expenses are processed by Oracle Charges.

1.2.7 Human Resources (HRMS)
Employee information is maintained in Oracle HRMS and used by the Resource
Manager. Oracle Support uses employee information for assigning service
requests and tasks to employee resources.

1.2.8 Install Base
Oracle Install Base stores information about all products that are of interest to
the customer. This information can be accessed using the item serial number or
by a customer’s site identifier. This allows you to identify the nature of the
equipment or software before creating a service request.

1.2.9 iSupport
Oracle iSupport allows a customer to log, view and update a service request
with the support organization through a web interface. Upon receipt of the
request, Oracle Support routes the request through the various steps that lead to
problem resolution.

1.2.10 Knowledge Management
More than eighty percent of the requests for assistance from customers coming to a
customer service center involve problems that have known solutions. Oracle
Support uses Oracle Knowledge Management to leverage a knowledge base of
previously reported problems and their resolutions. As new service requests are
logged, support personnel can search the knowledge base to identify solutions.
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1.2.11 Quality
You can set up collection plans in Oracle Quality that capture relevant data as
service requests are logged by customer support personnel. Collection plans may
capture data related to a customer, product, product line, etc. You can then analyze
this data in Oracle Quality to answer queries such as what are the most common
problems faced by users, or products which cause the most problems. The captured
data can be exported to perform detailed statistical analyses.

1.2.12 Quality Online
Oracle Quality Online is a defect and enhancement tracking application. The
integration of the Service Request module with Oracle Quality Online allows
you to create a defect or an enhancement from a service request. The service
request can be automatically linked to the defect or enhancement for tracking
purposes.

1.2.13 Scripting
Oracle Scripting guides the support agent through the process of identifying and
resolving the customer’s issue. Scripting enables the agent to ask step by step
relevant questions even in unfamiliar business contexts.

1.2.14 Telephony Manager
If your customer service center handles a large volume of telephone calls, you can
automate your call center by using Oracle Telephony Manager. Based on call
characteristics, calls can be intelligently directed to an appropriate agent, who can
access information entered by the customer before picking up the phone.

1.2.15 Universal Work Queue
The Universal Work Queue (UWQ) provides a place to view and select support
agent work which includes work from various media types such as telephone, email
and the web. The UWQ lists all media work (email, outbound calls, inbound calls)
and non-media work (Service Requests, Tasks). The Service Request node of the
UWQ is comprised of three tiers. The first tier, My Service Requests, displays a list
of service requests owned by the user. The second tier, My Group’s Service
Requests, displays a list of service requests that have no owner and are assigned to
the user’s Group. The third tier, My Team’s Service Requests, displays a list of
service requests that have no owner or group and are assigned to the user’s Team.
The service requests are sorted by severity level.
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Key Features
1.2.16 Workflow
Once service requests are logged, you can route them to service personnel in your
organization and move them through a workflow-based resolution process tailored
to your own unique business requirements. Using Oracle Workflow, you can
implement procedures that automatically notify service personnel about their
assignments.

You can define business rules to identify service requests that violate your service
standards or response guidelines, and then automatically take corrective actions or
escalate those requests to the appropriate person. Based on parameters such as
service request type, a service request can follow a resolution process optimized for
that situation. You can analyze the exact routing of each service request to identify
and eliminate the bottlenecks in your service request resolution process.

1.3 Key Features
The Service Request module helps you to manage customer requests for service in
the following ways:

� Record customer information quickly.

� Confirm customer and product information; name, number, product, system, or
serial number.

� View a customer profile.

� Alert support agents about critical customers.

� Describe the customer’s request for service.

� Define the service request status, type, severity, and urgency.

� Verify service contract entitlements automatically.

� Assign problem and resolution codes to each service request.

� Link service requests to defects, enhancements or related service requests.

� Search a knowledge base to expedite the resolution of service requests.

� Contribute to the knowledge base.

� View interaction history.

� View notes and saved knowledge base solutions for a service request all at once.

� Create multiple tasks for a service request.
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� Assign the appropriate resource to perform the task.

� Provide an audit trail of service request changes.

� Send a service request report by email or fax by using Fulfillment.

� Create a defect related to a service request.

� Create charges related to a service request.

� Find existing service requests by using a comprehensive set of search criteria.

� Escalate a service request.

� Update counters.

� Use Oracle Workflow to automate business processes used during service
request resolution.

� Use Oracle Quality to collect quality control information linked to service
requests.

1.4 Oracle Support Business Flow
The Service Request window functions as the central reaction point for a customer
support agent who needs to respond to a customer request. An interaction between
the customer and the support agent results in either an immediate resolution of the
problem or a task assignment to qualified individuals. The customer support agent
uses several application functions to facilitate a response to a customer problem.

A typical scenario for a customer calling for assistance is given below:

� A support agent accepts a customer call from the Universal Work Queue.

� The agent identifies the customer using the Contact Center and optionally
views the customer profile. The agent can update the customer information.

� The agent verifies contract entitlement and logs a new service request, or views
an existing service request.

� The agent searches the knowledge base for solutions to the customer problem.

� The agent can create a task from the service request and assign it to himself or
to another person in the support organization. The appropriate workflow is
launched

� The agent can view the interaction history from service requests for the
customer.
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� The agent can view the service request log associated with the customer or issue
to understand the progress made toward resolution.

� The agent can link the service request to another service request.

� The agent can create a charge line to return a defective product or bill the
customer for the services provided.

� If the product is defective, or if it requires an enhancement, the agent logs a
defect report.

� The agent can escalate the service request and assign the escalation to an
account manager.

� The agent can send another agent a message using the messages functionality of
service request.

� If the customer demands a confirmation of the service request, the agents sends
a fulfillment request containing the history of the service request to the
customer.

� The agent can contribute to the knowledge base after solving the problem.

� The agent can complete a collection plan to capture quality information used to
improve business processes.

The overall process that facilitates the solution to a customer problem varies with
each instance, but the process always involves a service request.
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Managing Service Requests

This chapter provides process-oriented, task-based procedures for using Oracle
Support to perform essential business tasks.

The following topics are covered:

� Overview of Creating a Service Request

� Accessing the Service Requests Window

� Finding an Existing Service Request

� Accessing Customer Information

� Viewing the Customer Profile

� Verifying Product Coverage

� Creating and Viewing Notes

� Searching the Knowledge Base

� Viewing the Service Request Log

� Managing Service Request Contacts

� Managing Customer Addresses

� Managing Tasks

� Viewing Customer Interactions

� Linking Related Documents to a Service Request

� Viewing Service History

� Printing a Service Request

� Wrapping up a Call
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� Contributing to the Knowledge Base

� Closing a Service Request

� Service Request Workflows

2.1 Overview of Creating a Service Request
The first step in solving a customer problem is creating a service request. The
customer information is validated and then the support agent opens a customer
service request that captures all the problem details.

To create a service request:
1. Navigate to the Service Requests window. See Accessing the Service Requests

Window for details.

If you need to view an existing service request, see Finding an Existing Service
Request for details.

2. Access the appropriate information about the contact and customer for
whom you want to create a service request. See Accessing Customer
Information for details.

Oracle Customer Support populates the Service Requests window with the
customer data logged in the Contact Center.

Based on the customer location, the time zone field shows the time zone of the
customer and also shows the time lag between the customer and the agent.

3. Optionally view the customer’s profile to get an understanding of the
customer’s criticality.

See Viewing a Customer Profile for details.

4. If the customer issue is about an Install Base item, select the Installed Base check
box and verify product coverage. Service requests can also be created for
inventory items that are not part of the Install Base.

See Verifying Product Coverage for details.

5. Select values in the Type, Status, and Severity fields, if they are different than
the default values. Default values in these fields are governed by the profiles
setup. For more information on profiles, see Setting Up Oracle Support Profiles
in the Oracle Support Implementation Guide. Default fields are further
described under Service Request Defaults.
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6. Open the Workbench tab. Enter a brief description of the customer problem or
request in the Request Summary field.

7. You can select values for the Urgency and Problem Code fields. The Problem
Code categorizes the type of problem reported in the service request. Urgency is
described under Service Request Defaults.

8. The Resolution field can be populated when the service request is resolved.

9. You can select the time frame for the resolution of the problem in the Resolution
By field.

10. You can enter a note to further describe the problem.

See Creating and Viewing Notes for details.

11. You can search the knowledge base to find possible solutions for the customer
problem.

See Searching the Knowledge Base for details.

12. You can view the service request log associated with the customer.

See Viewing the Service Request Log for details.

13. You can update or add customer contact information.

See Managing Service Request Contacts for details.

14. You can update customer address information.

See Managing Customer Addresses for details.

15. You can create one or more tasks and assign the tasks to the appropriate
resource.

See Managing Tasks for details.

16. You can view the interaction history for this customer.

See Viewing Customer Interactions for details.

17. You can link the service request to a related service request.

See Linking Related Documents to a Service Request for details.

18. You can view the service history for this product or product/customer
combination.

See Viewing Service History for details.

19. Save the service request.
Managing Service Requests 2-3



Overview of Creating a Service Request
A Service Request number is assigned and displays in the Request field. You
can give this number to the customer as reference.

20. Wrap up the call.

See Wrapping up a Call for details.

21. When the service request is resolved, you can optionally contribute to the
knowledge base.

See Contributing to the Knowledge Base for details.

22. Close the service request after it has been resolved.

See Closing a Service Request for details.

Service Request Defaults
Service request default values, specified by user profiles, help you enter service
requests quickly. You can set user profiles to default values in the following fields as
you enter service requests:

� Type - Categorizes the service request and can be related to relevant status
codes and workflow processes.

� Status - Indicates the current state of the service request.

� Owner - Indicates the person who is responsible for resolving the service
request.

� Owner Type - Shows the resource category of the Owner and the choices are
Employee, Group or Team Resource.

� Group -

� Group Type -

� Severity - Reflects the support agent’s perception of how critical the customer
issue is.

� Urgency - Reflects the customer’s perception of how critical the issue is.

� Note Type - Categorizes notes and allows certain notes to be used when
searching the knowledge base.

� Note Status - Indicates who has access to view the note and the choices are
Publish, Public or Private.

� Knowledge Base Solution Type - Categorizes knowledge base solutions.

� Task Priority - Indicates the relative priority of a task.
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� Task Status - Indicates the current state of the task.

� Task Type - Categorizes tasks and is used for linking to workflow processes.

� Task Owner - Indicates the person who is responsible for monitoring the
progress of a task.

� Task Owner Type - Shows the resource category of the Task Owner and the
choices are Employee, Group or Team Resource

� Task Assignee - Indicates the person who is assigned to do the work in a task.

� Task Assignee Type - Shows the resource category of the Task Assignee and the
choices are Employee, Group or Team Resource

� Make Public check box - Allows the service request to be viewed by customers
via iSupport.

You can override these defaults if necessary by changing the appropriate profile
options. For more information, see Setting Up Support Related Profile Options in
the Oracle Support Implementation Guide.

2.2 Accessing the Service Requests Window
The Service Requests window is the central reaction point for a customer support
agent who needs to respond to a customer request. Normally, you use the Service
Requests window to create and manage service requests. Service Requests can also
be created from the Service Request tab in the Customer Management Contact
Center window.

The Service Requests window contains folder block properties which you can
use the change the display of the service request fields to meet your specific
needs.

To access the Service Requests window:
1. Select the Customer Support Responsibility. The Customer Support Navigator

window appears.

2. Use the following navigation path to open the Service Requests window:

Service Requests—>Create Service Requests
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Overview of the Service Request Window
The Service Request header region contains four regions: Contact, Customer,
Subject and Request. The Contact region displays the details about the primary
contact for the Service Request. The Customer region displays information about
the customer for which the Service Request is logged. The Subject region displays
information about the product and contract for which the Service Request is logged.
The Request regions displays details about the Service Request attributes. To see all
of the fields in each region, you must use the scroll bar to scroll down.

The Service Request window contains nine tabs. Each tab allows access to a function
that contributes to the process of managing a service request. The support agent can
manage customer information, problem details, problem resolution, service history,
and task assignment to assist and sustain a support center.

The following list explains the functions supported by each tab in the Service
Request window.

Product Coverage
� View and edit product attributes.
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� View and select the contract entitlements.

Workbench
� Enter the problem description and notes of various types.

� Search the knowledge base.

� View respond by date and enter expected resolution dates.

� Delete a knowledge link.

� Update a solution with an outcome.

Log
View the history of various events in the lifecycle of a service request.

Contacts
View and select customer contact information for a service request.

Addresses
View and select customer billing, shipping, and installation address
information.

Tasks
View, create and assign tasks associated with a service request.

Interactions
View the customer interaction history.

Service History
View the service history of a specific product or component.

Related Documents
View or link related service requests and defects associated with a service
request.

Additional functionality related to service requests such as entering a charge,
creating a defect, viewing audit history, sending a fulfillment request, and initiating
an escalation can be accessed from the Tools menu of the Service Requests window.
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2.3 Finding an Existing Service Request
Use the Find Window to retrieve service requests from the database or product
information from the installed base. Oracle Support provides two search levels:
Basic and Advanced. Basic search is selected by default.

After executing a search, the service request(s) matching your search parameters are
displayed in the results area of the Find window. You can select any of the retrieved
service requests and then click OK to view its details in the Service Requests
window.

� Using Basic Search

� Using Advanced Search

To find a service request using basic search:

1. Select the parameters based on which you want to search for the service
request. You may select from the following parameters:
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� Contact Information - You must select a value from the Type list of values to
enable the following fields in the Contact region.

* Number

* Last Name

* First Name

* Phone number

* Email address

� Customer Information - You must select a value from the Type list of values
to enable the following fields in the Customer region.

* Number

* Name

* Account

* Phone

* Country

� Subject Information - Check the Installed Base check box to query only from
the customer’s list of installed products.

* Product

* Reference

* Serial number

* System

* Tag

* Contract

* Line

� Service Request Information

* Number

* Type

* Status

* Group

* Group Type
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* Owner

* Owner Type

� Task Information

* Number

* Status

* Type

� Task Assignee Information

* Type

* Name

2. If you are performing the search using a text string as the parameter:

a. Select a search option to indicate how the text string you enter in the
Keywords field is to be used for the search. This search is not case
sensitive. You may select from the following options:

Any Word: Finds service requests that contain any of the keywords in
summary or notes.

All Words: Finds service requests that contain all the keywords, in any
order, in summary or notes.

Phrase: Finds service requests that contain an exact match as the keywords
in summary or notes.

b. Select where the search is to be performed. The choices are:

� Summary check box to search only in the request summary

� Notes check box to search only in the notes associated with service
requests.

� Both Summary and Notes check boxes to search in both the service
request summaries and notes.

c. Enter the text string to be used for the search in Keywords field.

3. Click Search to find matching service request(s) based on the parameters
you have specified. Service requests created since the last time the Service
Request Synchronize Index program was run are included in the search.
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To find a service request using advanced search:
1. Open the Advanced tab.

2. Define the logical condition(s) to be satisfied for identifying and retrieving
service request(s). You can build your arguments around customer number,
contact name, or severity level. To define an argument:

a. Select the item for which the argument is to be defined.

b. Select a logical operator to indicate how the item and value combination is
to be used to identify service requests.

c. Select the value based on which service requests are to be retrieved.

Note: Each item, condition, and value combination is considered an argument.
The AND operator is used in the background to create a complex argument if
you define more than one condition. All the conditions set forth by a complex
argument must be satisfied for identifying and retrieving service requests.

3. Click Search to find matching service request(s) based on the arguments you
specified.
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2.4 Accessing Customer Information
When creating a service request, you can access customer information by starting
with the entry of either the Contact Type or Customer Type fields. Alternatively,
you can expedite the entry of service request information by entering information in
one of the fourteen service request entry points.

Following are descriptions of the two methods for accessing customer information:

� Accessing Customer Information Using Contact and Customer Type

� Accessing Customer Information Using Additional Entry Points

2.4.1 Accessing Customer Information Using Contact and Customer Type
Oracle Support leverages the customer model which supports the Business to
Business (B2B) and Business to Consumer (B2C) model. This approach focuses on
relationships as being the key differentiator of a customer. The Service Requests
window supports the customer relationship with the use of Contact Type and
Customer Type fields. By identifying the correct combination of Contact Type and
Customer Type, the application determines which additional fields are required,
which fields are optional and which fields do not apply.

You can select a value in either the Contact Type or the Customer Type field first. If
you complete the Contact Type field first, the possible combinations follow:

For example, if you select a contact type of Person and select the contact name from
the list of last names, the Customer Type field defaults to Person and the person
information is displayed in the customer fields. If you select a contact type of
Relationship, the list of values for the contact last name displays the party with all

Table 2–1 Possible Contact Type - Customer Type Combinations

Contact Type Customer Type

Person Person - Defaults from Contact

Employee Person - User selects from list of values

Employee Organization - User selects from list of values

Relationship Organization - Defaults from Contact list of values

Relationship Person - Defaults from Contact list of values
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the relationships. Depending on which value you select, the Customer type field
defaults to either Person or Organization.

If you complete the Customer Type field first, the possible combinations follow:

For example, if you select a customer type of Person and then you select a person by
customer number, than the Contact Type field defaults to Person. If you want to
change the contact, you can change the Contact Type to Relationship or Employee.
If you select a customer type of Organization, you can select a customer by number
or any other customer field and then select a contact type of either Relationship or
Employee.

2.4.2 Accessing Customer Information Using Additional Entry Points
Oracle Support provides fourteen entry points into the service request. An entry
point is defined as one field that must be entered with a valid value and based on
the information in that one field, several related fields are automatically populated
in the service request header. This enables you to quickly access customer
information while creating a service request.

The following entry points are available:

� Account

� Contact Email

� Contact Name

� Contact Number

� Contact Phone

� Contract

Table 2–2 Possible Customer Type-Contact Type Combinations

Customer Type Contact Type

Person Person - Defaults from Customer

Person Relationship - User selects from list of values

Person Employee - User selects from list of values

Organization Relationship - User selects from list of values

Organization Employee - User selects from list of values
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� Customer Email

� Customer Name

� Customer Number

� Customer Phone

� Employee Number

� Install Base Serial Number

� Reference

� System

For example, if you enter only the Customer Number in the Service Requests
window, the following fields related to the customer with this customer number
are populated automatically: Contact Name, Contact Phone, Contact Email,
Customer Name, Customer Phone, Customer Email, and Account. The
following additional fields are populated if only one value has been assigned to
this customer: System, Reference Number, Serial Number, and Contract.

2.5 Viewing the Customer Profile
Customer Profile information summarizes customer information and indicates if a
customer is critical, thereby helping you make intelligent decisions while providing
customer support. The profile entries appearing in the customer profile are typically
set up by a system administrator, and contain a set of predefined key indicators.

Prerequisite
Customer profiles need to be defined for a customer before they can be viewed in a
service request. For information on creating customer profiles, please refer to the
Oracle Customer Care Implementation Guide.

To view a customer profile:
1. Navigate to the Service Requests window.

2. Create or query a service request.

3. Click Profile. The profile window opens and displays the predefined key
indicators for this customer.
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4. Double-click on a key indicator to view a summary list of what comprises that
indicator. For example, double-clicking on Open Service Request (a key
indicator) displays the a list showing all open service requests for the selected
customer. This list displays information such as the service request number,
incident date, problem code and resolution code.
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5. Double click on any line to view details of that service request. The Service
Requests window containing details of the service request opens.

6. Click Refresh in the Profile window to view the latest information for the
customer.

2.6 Verifying Product Coverage
The Product Coverage tab allows you to view information about the customer’s
contractual coverage for the product or service for which the service request is
logged. This tab contains information about the product attributes as well as the
contracts.

The product attributes and contracts information help you to:
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� Confirm the product details with the customer.

� View contract details. While logging a service request, you can look up
contracts associated with the customer/site/product to ensure that all
contractual requirements like coverage times, response times, effective dates,
billing rates and entitlements are met. An organization may or may not enforce
contract validation.

Prerequisite
Customer products, contracts and coverages must be defined before they can be
viewed in a service request.

To verify product coverage information:
1. Navigate to the Service Requests window.

2. Access the appropriate information on the caller for whom you want to create a
service request. See Accessing Caller Information for details.

3. Select the Installed Base check box if the customer issue is about a customer
product. If this check box is selected, the Product list of values displays only the
products installed at the customer site, otherwise it displays all inventory items.
The System and Reference Number fields are enabled only when the Installed
Base check box is selected.

4. If the Installed Base check box is checked, select a product and optionally, a
serial number for the product. If you selected the Installed Base check box,
you can select a serial number from a list of values. If not, Serial Number is a
user enterable text field. Alternatively, click Find to search the installed base
for customer products.

5. To view product information, open the Product Coverage tab. The fields in
the Product Coverage tab are updated to display appropriate product
attribute and contract information.

6. To change or add a product related attribute, click Product Configuration.
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7.

8. The contracts region of the Product Information tab displays the contract
information related to the service request being logged. Click Get Contracts to
view contract information based on the values entered for Customer, Account,
Site, Installed Base Product, Item and System fields. The contracts region
displays all active contracts available based on the information entered in the
service request. To view all contracts, click the All Contracts radio button prior
to clicking Get Contracts.

9. Select a contract for service coverage by selecting the Selection check box
next to the desired contract row. The date in the Respond By field of the
service request is defaulted based on the contract selected.

10. To view coverage information for a particular contract, double-click the
contract number in the Contract region. The Service Contracts Coverage
window opens.

� The Service Contracts Coverage window displays details like coverage
name, description, type, business processes to which this is attached,
preferred engineers as per contract, effective dates and any exception
coverage.
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� The Coverage Times tab shows service coverage hours by weekday.

� The Reaction Times tab displays reaction time according to the severity of
the problem.

� The Billing Types tab shows the billing type, rate, and percentage coverage.
For labor billing type, you can also view bill rate and percentage of
discount, if applicable on the rate.

11. Close the Service Contracts Coverage window to return to the Service
Requests window.

2.7 Creating and Viewing Notes
Notes in a service request are used to document the description and progress made
toward resolution of the customer issue. Notes are used to capture details to search
the knowledge base for solution statements. Notes are also used to create new
solution statements to contribute to the knowledge base.

Access to view notes in a service request is available at three levels:

� Private - Only the support agent who created the note can view the note.

� Public - All internal employees can view the note.

� Publish - All internal employees can view the note and customers can view
the note through iSupport.

If you print a service request, you have the option of selecting which note status
should be included on the printout. You can update the status of an existing note.

To create a note:
1. Navigate to the Service Requests window.

2. Create a service request or query an existing service request.

3. Open the Workbench tab.
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4. Select the type of note you want to create in the Type field. Certain note
types must be used if you want to search the knowledge base. Typical note
types used for searching are Symptom, Cause, Action, Problem and
Solution.

5. You can update the note type of a previously created note, if needed.

6. Select the appropriate status for the note in the Status field.

7. Enter a brief description of the note in the Note field.

8. If you want to enter more note text, click Details to open the Note Details
window. You can additional text up to 32 K in size. Click OK to return to the
Notes window.

9. Save the note.

10. The note appears in the spreadtable in the Notes and Knowledge base
elements region.

11. If you want to specify Related To information for the note while creating a
note, you can access the main notes window by selecting the Notes option
on the tools menu.
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This Notes window allows you to create a note while specifying Related To
and Related Values. If a note is created from this window, the Related To
field defaults to Service Request and the Related Value defaults to the service
request number.

12. The Notes windows displays notes in two tabs: Notes and Summary. The
Notes tab displays the notes in a summarized list form in a spreadtable. The
summary tab displays the notes as text in a chronological or reverse
chronological order. You can change the chronological view by clicking on
the Latest First check box.

13. To find a note:

a. Open the Notes window.

b. Click on the Find tool bar button to open the Notes Find window. Enter the
appropriate search parameters and click Find.

2.8 Searching the Knowledge Base
While logging a service request, you can search for a solution to the customer issue
in the knowledge base if you are using Oracle Knowledge Management. The
knowledge base is a repository of solution sets that have been previously
contributed.

The knowledge base search can be based on:

� Keywords

� Similar statements

� Symptoms, Causes, Actions or other defined knowledge statement types

� Solution sets

Knowledge solutions and statements are version controlled. You can enhance or
modify solutions or statements in the new Knowledge Management HTML user
interface.

Prerequisite
Oracle Knowledge Management System must be properly set up.

To search the knowledge base:
1. Navigate to the Service Requests window.
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2. Create a service request or query an existing service request.

3. Click the Search Knowledge Base button on the Workbench tab. This button is
located in the upper right corner of the Workbench tab. The Knowledge Base
Search window opens.

4. The following information from the service request is passed to the Knowledge
Base search window.

� If your note was saved in the service request using a Note Type that has
been mapped to Knowledge Management, then the note text is defaulted to
the search screen. Note types are setup in the Knowledge Management
application.

� Product and Platform

� Service Request summary is defaulted into the Keywords for searching.

5. You can view the details of solutions found and select the solutions that are
useful for the resolution of your service request.

You can link relevant solutions to your service request so they are available for
viewing in the Workbench tab and the Log tab of the service request. You can
also make a local copy of a solution and make modifications to it. These
statements are stored as Notes and are not be available in future Knowledge
Base searches.

6. If you do not want a solution to be linked to your service request, you click
Delete Link. If a solution does not solve the customer’s issue, you can check the
Did Not Solve check box.

For additional information about Knowledge Management, refer to the Oracle
iSupport Concepts and Procedures Guide.

2.9 Viewing the Service Request Log
The Log tab provides a centralized location for viewing the history of a service
request. It displays a chronological view of all activities, tasks and notes entered for
a service request, as well as all changes to the audited fields, and all knowledge
notes linked to this service request.

Prerequisite
You must save the service request before you can view the log.
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To view the customer contact log:
1. Navigate to the Service Requests window and query an existing service

request.

2. Open the Log tab. This tab displays the history associated with the service
request in a scrollable window.

3. Select one of the following check boxes to display the type of information you
want to view:

� All - displays all activities.

� Audit - displays changes to the Type, Severity, Status, Summary, Group
Type, Group, Individual Type, Individual and Product fields.

� Notes - displays all notes.

� Knowledge - displays knowledge documents linked to this service request.

� Activity - displays all interactions

� Task - displays all tasks.

� Latest First - reverses the chronological order.
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4. Click Refresh to view the updated activity.

5. If you want to print the activity shown in the log, click Print Friendly Format.

2.10 Managing Service Request Contacts
Companies often provide multiple contacts for a service request. The Contacts tab
in the Service Requests window provides a central repository for obtaining
information on how to contact a specific person related to the service request.
You can also use the Contacts tab to designate a primary contact for the service
request. You must use the Customer button to navigate to Contact Center if you
want to add new contact information.

Prerequisite
Contacts must be defined before they can be associated with service requests. To
update existing contact information or create new contacts, you can access the
Contact Center by clicking the Customer button from the Service Requests window
or using the Quick Menu to navigate to the Contact Center window.

To associate an additional existing contact to a service request:
1. Navigate to the Service Requests window and create a service request or

query an existing service request.

2. Open the Contacts tab. Contact information from the service request is
displayed.
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3. To associated additional contacts to this service request, select the contact type
and the contact’s first and last name from the list of values. The value in the
Contact Type field defaults from the Default Contact Type profile option.

4. You can indicate who the primary contact is by checking the Primary check box
next to the desired contact. This action changes the primary contact in the
Service Request header and defaults the selected contact point information into
the appropriate fields.

5. Save the service request. The contact details are saved along with the service
request.

To create a new contact from a service request:
1. Navigate to the Service Requests window and create a service request or

query an existing service request.

2. Click Customer to open the Contact Center window.

3. Click New to open the Caller Information window.

4. Choose a caller type in the Caller Type field.
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� To create an organization for a B2B customer, select Organization as the
caller type.

� To create a person for a B2C customer, select Person as the caller type.

� To create a contact for a B2B customer, select Caller as the caller type.

The fields available to you depend on your selection in the Caller Type field. All
selections result in the display of Phone, Party, Account Name and Email fields.
If you select Organization as the Caller Type, the Organization and Relation
fields are displayed. If you select Person or Contact, the fields related to the
caller’s name are displayed.

5. If you are creating a new caller for a customer, enter a relation. Also choose the
party you want to associate with the caller. If you forget to enter the
relationship during the creation step, the party relationship will not get created
and you must create the relationship from the Contact Center Relationship tab.

6. Optionally enter an email address in the Email field.

7. Select the Account check box if you want to create an account for this caller.

8. The Address field is actually a Flexible Address format. When you click on the
field, the address flexfield window appears where the user can enter all the
address attributes such as Address Lines, City, State, Zipcode. The address
flexfield attributes are based on what you define in the setup for each country.
The default for the New window is US. Refer to the Oracle Customer Care
Implementation Guide for setup of address flexfield.

9. Optionally enter effective dates in the Effective From and Effective To fields.

10. Click OK to save the information to the customer master.

11. The system automatically generates and assigns a Party Number to the caller. If
the Account check box is selected, an account is created for the party.

12. Close the Contact Center to return to the Service Requests window.

13. Now you can select your new contact from the Last name list of values.

2.11 Managing Service Request Customer Addresses
The Addresses tab contains customer information for installation, billing and
shipping addresses.
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To record customer address information:
1. Navigate to the Service Requests window and query an existing service

request.

2. Go to the appropriate region in the Addresses tab: Bill To, Ship To or Installed
At.

If the service request is logged against a customer product, the Installed At
address is taken from the Install Base application. You can override the address
with an address from any related customer.

3. Select the appropriate party from the Party list of values. The Party list of values
displays all related parties, filtered by the customer type selected in the service
request header.

4. Select an address from the list of values

5. Save your work to record the address information.

To add a new customer address:
1. Open the Contact Center window by clicking the Customer button or using the

Quick Menu from the Service Requests window.
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2. Open the Addresses tab in the Contact Center window.

3. Click the Add New Record icon in the tool bar.

4. Select the appropriate option from the View By dropdown box. The choices are
Organization, Person, Caller and Relationship.

5. Select a status of Active.

6. Enter a descriptive name to describe the location for the party in the Site Name
field. An example of site name is ’HQ’ as the site name for the address
representing Oracle’s headquarters.

7. Optionally enter a mailing name in the Addressee field. An example of an
addressee is ’Attention: Accounts Payable’.

8. You can select an existing address in the Address1 list of values or you can
create a new address. This list of values contains all addresses in HZ_
LOCATIONS. If you select an existing address, the remaining address fields are
automatically populated. If the location is not available from the list of values,
you can create a new location by entering the appropriate values in the
remaining applicable address fields.

9. Save your changes.

10. You can create a usage for each address, such as Bill to or Ship to. Select a usage
from the Usage list of values and a status from the Status list of values.

11. Save your changes.

12. In the Primary Usage region, you can assign an address as primary for each
usage. Select a usage from the Usage list of values and then select the address
you want to be primary for this usage from the Address list of values.

13. To associate a contact point with an address site, click Site Contact Points. The
Site Contact Points window opens.The party address is displayed by default.
Select a contact method from the Contact Method list of values. All contact
methods are seeded values. The valid contact methods are Phone, Web and
Email, EDI, and Telex.

14. The next fields vary depending on the contact method you select:

a. If you select Phone as the contact method, select a value from the Type list
of values. Enter values in the Country Code, Area Code, Value and Ext
fields, if applicable. The Value field is for the main phone number and the
Ext field is for the phone extension.
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b. If you select Web as the contact method, the form takes you to the Value
field for entry of a URL.

c. If you select Email as the contact method, the form takes you to the Value
field for entry of an email address.

d. If you select EDI, enter the appropriate value in the Value field.

e. If you select Telex, enter the appropriate value in the Value field.

15. Optionally enter values in the Best Time From and Best Time To.

16. If you do not want a contact method to be used, check the Do Not check box.

17. Save your work.

2.12 Managing Tasks
The Service Requests window provides the functionality for creating, assigning,
managing, and prioritizing various tasks through its Tasks tab. A task is a unit of
work that needs to be completed to resolve a service request. You can associate task
types with workflows to control the business flow of the task.

After you create a service request, you can create tasks for yourself or assign tasks
to other resources to direct the reactionary response for resolving the customer
issue. For example, you can create a task to call back a customer or a task to
dispatch a service engineer to make a repair at a customer site.

You can create a task by manually entering all the relevant information or by using
a template.

See Also:
� Creating a Task Manually

� Creating a Task Using Task Template

� Entering Task Details

� Defining Resource Requirements

� Setting Task Dependencies

� Linking Tasks to Source Documentation

� Setting Recurrence Schedule

� Viewing Audit History for the Task
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2.12.1 Creating a Task Manually

Prerequisite
If you want to launch a workflow, the workflow must be associated with the task
type in use.

To create a task manually:
1. Open the Task tab in the Service Requests window.

2. Values in fields such as Status, Type, Priority, Owner Type, Assignee Type, and
Owner are displayed by default based on profile options. You can use the list of
values associated with these fields to change the default values.

The Task Type can be used to associate this task with a workflow. The Task Type
list of values shows only those task types which are associated with service
requests.

3. Enter a name for the task in the Name field.

4. In the Desc. field, enter a brief description about the task.
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5. If needed, in the Parent field, select a task to which this task is to be linked.
Normally, you would select a parent task if the task you are creating is a follow
up on another task.

6. Optionally select the Restrict Closure flag. A task with restricted closure means
that if this task is related to a service request, the service request cannot be
closed until this task is closed.

7. You may use the default values in the Assignee and Owner fields or change
them by selecting from the list of values. You can also change these fields by
using the Assignment Manager. To access the Assignment Manager, click the
Assignment Manager button next to the fields. The Assignment Manager looks
up the Calendar, Territory Management and Resource Management modules to
assign an appropriate resource for the job based on skill set, availability and
assigned territory. For additional information about the Assignment Engine,
refer to Oracle CRM Foundation Concepts and Procedures.

8. Select the Planned Start and End Dates.

9. Save the task. A system generated task number is displayed in the Num field.

10. To manually launch workflow, click Launch Workflow. A message is
displayed indicating that workflow was successfully launched.

11. To access the Task Manager, click Task.

12. To create notes for this task, click Notes.

13. Click More to open the Task Details window to enter details such as resource
assignments, dependencies, references, and contacts.

See Entering Task Details for more information.

2.12.2 Creating a Task Using the Task Template

To create a task using the task template:
1. Open the Task tab in the Service Requests window.

2. Click Use Template in the Task tab.
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3. The Create Tasks from Template Group window opens.

4. In the Template Group field, select the template group based on the task which
is to be created. Values in the Source Document, Source Name, Owner Type and
Owner fields are defaulted. You may change these values, if needed.

5. Click Create Tasks.

2.12.3 Entering Task Details
The Task Details window allows you to enter details such as resource assignments,
dependencies, references, and contacts for the current task. To open the Task Details
window, click More in the Task tab of the Service Requests window.

See Also:
� Defining Resource Requirements

� Setting Task Dependencies

� Linking Tasks to Source Documents

� Setting Recurrence Schedules

� Viewing Task Audit History

2.12.3.1 Defining Resource Requirements
Define resources as the tools and/or personnel needed to complete a task. The task
owner assigns and schedules the required resources after choosing the best
available options.
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To define resource Requirements:
1. Open the Task Detail window by clicking More in the Task tab. The Resource

tab opens by default.

2. In the Resource Type field, select the resource type needed to solve the customer
issue.

3. In the Unit field, enter a numeric value. This value determines the numbered
amount of a particular resource, for example, three hours.

4. Select the enabled check box if it is not already checked by default.

5. In the Assignments region, select from the list of values in the Type and Name
fields.

6. Select the status of the task in the Status field.

7. If you want to schedule a resource, select the Schedule check box. To complete
scheduling:

a. Enter scheduled distance and duration values, and select a unit of measure.

b. If you want to update actual schedule information, enter the actual Start
and End dates.

c. You may use the Assignment Manager to select and schedule the resource.
To open the Assignment Manager, click the Assignment Manager button.

8. Click OK to save your work.

2.12.3.2 Setting Task Dependencies
Task dependencies store the desired order among tasks. Dependencies are not
enforced within CRM applications and dependency information is provided for
exporting data to third party applications.

Prerequisite
You must create a task before you can set dependencies for it.

To set task dependencies:
1. From the Task Detail window, open the Dependencies tab.

2. Select the dependent task number from the list of values in the Task Number
field. The task name is automatically displayed.
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3. Enter a numerical value in the Offset field. This value determines the time that
separates the action of initial tasks from subsequent tasks. Use this feature to
organize tasks with time sensitive restrictions.

4. Select a unit of measure in the UOM field.

5. Click OK.

2.12.3.3 Linking Tasks to Source Documentation
Creating references to a source document allows you to reference pertinent
background information. Source documentation could be the original service
request that resulted in the creation of a task.

To link a task to its reference document:
1. From the Task Detail window, open the References tab.

2. Select from the list of values in the Document Type field.

3. Enter the identification number of the source document in the Number field.

4. Click OK.

2.12.3.4 Setting Recurrence Schedules
If the task is to be performed on a regular basis, you may specify a daily, weekly,
monthly, or yearly schedule.

To set a recurrence schedule for a task:
1. From the Task Detail window, open the Recurrences tab.

2. Select the frequency for the recurrence of the task by selecting the Daily, Weekly,
Monthly, or Yearly button. Your selection determines the fields available in the
Recurrences tab.

3. In the Start field, select the date after which the task is to be repeated.

4. Optionally, in the End field, select the date after which the task will not be
performed.

5. Set the recurrence schedule.

6. Click OK.
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2.12.3.5 Viewing Audit History for the Task

The Audit tab of the Task Detail window presents historical information on the
changes that have been made to the task.

2.12.4 Task Default Fields
The following fields are defaulted from profile options when creating a task.

� Status - Indicates the current status of the task.

� Type - Categorizes the task and is used to define criteria for reporting on tasks.

� Priority - Indicates the relative priority of the task.

� Owner - Indicates the person who is responsible for monitoring the progress of
the task.

� Owner Type - Shows the resource category of the Task Owner and the choices
are Employee, Group or Team Resources.

� Assignee - Indicates the person who is assigned to do the work described in the
task.

� Assignee Type - Shows the resource category of the Task Assignee and the
choices are Employee, Group or Team Resources.

� Private and Publish Flags - If the Publish Flag is set then all support agents can
view the task. If the Private Flag is set, then only the task owners can view
the task.

2.13 Viewing Customer Interactions and Activities
The Interactions tab of the service request displays the entire history for the
service request. For example, you can view all closed interactions for a service
request in this tab. Closed interactions occur when a support agent uses the End
Interaction button after the interaction is complete.

An interaction can have multiple activities associated with it. For example, an
incoming call is an interaction and its associated activities could be a service request
and some tasks.

To record and view customer contact interactions:
1. Navigate to the Service Requests window and create a service request or

query an existing service request.
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2. Open the Interactions tab. The Interaction tab displays the various interactions
that your organization had in the past with this customer.

3. A profile option defines the number of interactions that is displayed. To see all
interactions, click All Interactions.

4. You can drill down to view activities to which the Interaction is associated by
double clicking on the number of the related activity.

2.14 Linking Related Documents to a Service Request
You can link a document to one or more service requests. For example, if several
customers report the same problem occurring in a product, you can link these
service requests together, or link each of these service requests to the service request
that contains a thorough description of the problem resolution.

A service request can also be linked to a defect. When a defect is created from a
service request, it automatically creates a link between the defect and the service
request.

When a service request is created by using the copy command from a service
request, you can, optionally, create a link between these two service requests.
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To link related documents to a service request:
1. Navigate to the Service Requests window and open a service request.

2. Open the Related Documents tab.

3. The Related To tree appears on the left side of the Related Documents window.
You can expand a node on the tree by clicking the + sign. The details of the
document selected on the tree are displayed in the fields on the right side of the
window.

4. In the Related Documents tab, select a document type of Service Request and
the document number to be related to this service request. The Summary,
Product, Status, and Severity fields for the selected document are displayed.

5. Select a link type from the Link Type field. The choices are Reference and
Duplicate.

6. Save your work to link the selected document to your service request.

7. You can delete a link by selecting a document on the tree structure and clicking
on the Delete Link button.
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8. By clicking on the Related From check box, the service requests which linked
this service request to them are displayed.

2.15 Viewing Service History
The Service History tab provides a view of the service requests that have been
created for a product or for a product and customer combination. The list of service
requests in this tab is based on the product and customer that is entered in the
header region of the service request.

To view service history:
1. Navigate to the Service Requests window and create a service request or

query an existing service request.

2. Open the Service History tab.

3. Select one of the following choices in the View By drop down list:

� Product Reference - Displays a list of service requests for all customers for
the Install Base product specified in the header region.
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� Component Reference - Displays a list of service requests for all customers
for the Install Base component specified in the header region.

� Sub-Component Reference - Displays a list of service requests for all
customers for the Install Base sub-component specified in the header
region.

� Product Item - Displays a list of service requests for the Install Base or
inventory item associated with the product specified in the header region.
This list is restricted to the customer specified in the header region.

� Component Item - Displays a list of service requests for the Install Base
or inventory item associated with the component specified in the header
region. This list is restricted to the customer specified in the header region.

� Sub-Component Item - Displays a list of service requests for the Install
Base or inventory item associated with the sub-component specified in the
header region. This list is restricted to the customer specified in the header
region.

2.16 Printing a Service Request
Service requests can be printed from three places. In the Service Request Log tab
and the Workbench tab, the button called Print Friendly Format can be used to
print a service request. You can also select the Print Request option in the Tools
menu regardless of which Service Request tab you are using.

After initiating the printing function, a browser page opens. You can then select
which Note Status(es) you want to include in the report.

2.17 Wrapping Up a Call
The following buttons are visible at all times from the Contact Center window
regardless of the tab you are using. To wrap up a call, you can use the Call Wrap Up
or End Interaction buttons, depending on the situation.

Call Information:
Use this button to open the Call Information window where you can view call (IVR)
parameters such as ANI, DNIS, Order, System, Account Code, and Service Request
Number which the customer enters while calling for customer support.
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Call Wrap Up:
Use this button to open the Call Wrap Up window where you can enter additional
information about the interaction with the customer. A default value is provided for
outcome, result, and reason, which you can override if required. You can optionally
enter additional information about the call in the Notes field, which is a new field in
11.5.6.

Each customer interaction results in two activities, which are displayed by default
when you open the Call Wrap Up window. The first activity is the result of querying
the customer. The second activity is the result of saving everything that was
updated during the customer interaction.

If you want to create additional activities, click the Add New Record icon in the
toolbar. Enter the details in the Outcome, Result and Reason fields and then save
your work. The values in these field are defaulted from profile options and you can
override them if needed.

The interaction is ended when you click OK. The Call Wrap and End Interaction
buttons are then disabled. Pressing Call Wrap Up to end the present interaction
signals that you are ready to accept new calls.
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End Interaction:
Use this button to terminate the customer interaction if there is no wrap up to be
done for the call. If you click End Interaction, the Call Wrap Up and End Interaction
buttons are disabled. Pressing End Interaction to end the present interaction signals
that you are ready to accept new calls.

Agent On Break:
Use this button to signal that you are on a break and are not available to accept
calls. The button label then changes to Agent Off Break. When you are ready to
accept new calls, click Agent Off Break to signal that you are back from the break.
If you plan to take a break, you must click Agent on Break before you click End
Interaction, because clicking End Interaction allows new calls to reach you.
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2.18 Contributing to the Knowledge Base
The integration of the Service Requests window with the Knowledge Management
System allows you to contribute new solutions to the knowledge base.

Prerequisites
Knowledge Management must be properly setup for this feature to work properly.

To contribute to knowledge base:
1. In the Service Requests window, create a service request, or query an existing

service request.

2. Click the Search Knowledge Base button in the Workbench tab to open the
Knowledge Base Search window.

Refer to Oracle iSupport Concepts and Procedures for details on how to contribute
to the Knowledge Base.

2.19 Closing a Service Request
When you resolve a service request, you can take the following actions:

� Enter a Resolution Code to categorize how the issue was resolved

� Create a note to describe how the issue was resolved

� Contribute to the knowledge base

� Bill the customer for charges incurred

� Update the status of the service request

Using Resolution Codes
Resolution codes can be used to categorize how service requests are resolved. If
your organization uses resolution codes, you can select a resolution code in the
Resolution Code list of values in the Service Request Workbench tab.

Creating a note to describe how the issue was resolved
When a service request is resolved, you can document in the service request how
the issue was resolved. To do this, follow the steps described in Creating and
Viewing Notes.
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Contributing to the knowledge base
If your service request was resolved using a solution that was not in the knowledge
base, you can contribute your new solution to the knowledge base. To do this,
follow the steps described in Contributing to the Knowledge Base.

Billing customers for charges incurred
If you need to bill the customer for charges incurred during the resolution of the
service request, refer to the steps described in Billing for Charges from Service
Requests.

Updating the status to close a service request
When the issue in a service request is resolved, you must record this by updating
the status of the service request.

1. Navigate to the Service Requests window.

2. Find the service request to be closed.

3. Open the Workbench tab.

4. Update the Status field to a value that represents a closed service request.

5. Save your work.

2.20 Service Request Workflows
When you create a service request for your customer’s issue, you can use the
technology of Oracle Workflow to drive the service request resolution process.
Workflow routes information to related parties inside and outside your enterprise
according to your business rules. The Service Request Workflow consists of
processes that you can view graphically in Oracle Workflow. Each process
comprises activities that together represent the flow of information required to
achieve service request resolution. Using Oracle Workflow you can create additional
activities to enhance and customize your workflow process. You can also use Oracle
Workflow to create your own custom workflow processes for each service request
type.

The Service Request Workflow is initiated when you enter a new service request
and you assign an employee to the request. The Call Support process within this
workflow automatically routes the new service request to the individual for
resolution, alerts the supervisor as needed when the current owner does not
respond to the request and allows the current owner to escalate or transfer the
request to the next level of support.
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2.20.1 Service Request Workflow Attributes
The Service Request Workflow has the following attributes associated with it. These
attributes reference information in the Service Request data model and are used and
maintained by activities throughout the workflow process.

Service Request Workflow Attributes

Display Description Type Format/Length

Initiator Role Workflow role name of process
initiator

Text 100

User ID Initiator’s application user
identifier

Number

Resp ID Initiator’s responsibility identifier Number

Resp Appl ID Initiator’s application identifier Number

Workflow
Administrator
Role

Workflow role name of Oracle
Service workflow administrator

Text 100

Request ID Internal identifier of the service
request

Number

Request Number User-visible service request
number

Text 64

Request Date Service request date Date DD-MON-YYYY

HH24:MI:SS

Request Type Service request type Text 30

Escalation History Escalation history Text 2000

Escalation
Comment

Optional escalation comment
provided by owner

Text 2000

Last Escalation
Comment

Last escalation comment Text 2000

Request Status Service request status Text 30

Request Severity Service request severity Text 30

Request Urgency Service request urgency Text 30

Owner ID Employee ID of current owner Number

Owner Name Name of current service request
owner

Text 240
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2.20.2 Seeded ’Call Support’ Workflow Process
When the Call Support process begins, it identifies information about the service
request, such as the service request number and owner. The process then sets a
response date that serves as a deadline by which the owner must respond, and

Owner Role Workflow role name of current
service request owner

Text 100

Request Summary Service request summary Text 80

Request Customer Customer who made the request Text 50

Inventory Item ID Inventory item ID from item
master

Number

Product
Description

Product description Text 240

Customer Product
ID

Customer product ID from
installed base

Number

Problem
Description

Problem description Text 2000

Expected
Resolution date

Expected resolution date of the
service request

Date DD-MON-YYYY

Response Deadline Deadline by which owner must
respond to notification

Date DD-MON-YYYY

HH24:MI:SS

Supervisor ID Employee ID of current owner’s
supervisor

Number

Supervisor Name Name of current owner’s
supervisor

Text 240

Supervisor Role Workflow role name of current
owner’s supervisor

Text 100

Previous Owner
ID

Employee ID of previous owner Number

Previous Owner
Name

Name of previous owner Text 240

Previous Owner
Role

Workflow role name of previous
owner

Text 100

Service Request Workflow Attributes

Display Description Type Format/Length
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sends an assignment notification to the owner. If the owner does not respond before
the response deadline, the process sends a notification to alert the owner’s
supervisor, sets a new response deadline and re-sends the assignment notification to
the owner. This continues until the owner takes action. If the owner resolves the
request and responds to the assignment notification with the Resolved result, then
the process closes the request and ends with a result of Resolved. However, if the
owner is unable to resolve the request and responds to the assignment notification
with the Escalate result, then the Escalation subprocess looks up the supervisor of
the current owner and reassigns the request to the supervisor. It then sets a new
response date for the new owner and sends an escalation notification to that
individual. This subprocess continues until the owner resolves the request.

In Oracle Workflow, the Call Support process consists of the following subprocesses
and activities:

� Notify Owner

� Escalate Notification

� Alert Supervisor

Descriptions of the activities that comprise the Call Support Workflow Process
follow.

Initial Request Activity
This activity initializes the workflow attributes that remain constant over the
duration of the workflow process.

Initialize Escalation History Activity
This activity initializes the Escalation History. It records the date and time of the
first owner assignment in the workflow process.

Get Request Attributes Activity
This activity initializes or updates the workflow attributes with the most current
values in the database.

Set Response Deadline Activity
This activity sets the date by which the service request owner must respond to the
notification.
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Notify Owner with Expiration Process
This subprocess initiates when a new service request is logged or when the service
request owner fails to respond before the assignment notification times out. For a
description of the activities included in this process, see Notify Owner with
Expiration Subprocess.

Escalation Process
This subprocess initiates when the owner is unable to resolve the service request
and chooses to escalate the service request to the next level of support. For a
description of the activities included in this process, see Escalation Subprocess.

Alert Supervisor Process
This subprocess initiates when the service request owner fails to respond before the
assignment or escalation notification times out. For a description of the activities
included in this process, see Alert Supervisor Subprocess.

Close Request Activity
This activity closed the service request by setting the status to Closed.

End (Resolved) Activity
This activity marks the end of the Call Support process. The process has a result of
Resolved.

2.20.3 Notify Owner Subprocess
This subprocess initiates when a new service request is logged or when the service
request owner fails to respond before the assignment notification times out. This
subprocess consists of the following activities.

Start Activity
This is a standard activity that marks the start of the subprocess.

Is Response Deadline Valid Activity
This activity verifies whether the response deadline is valid.

Wait for Owner Response Activity
This is a standard activity that waits until the time specified by the Set Response
Deadline activity.
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Notify Owner With Expiration Activity
This activity notifies the service request owner that a new service request is
assigned to him or her, with the note that he or she must respond to this notification
before the specified deadline. Otherwise, the supervisor will be alerted.

Notify Owner Activity
This activity notifies the service request owner that a new service request is
assigned to him or her. The only difference between this and the Notify Owner With
Expiration activity is that this activity does not have a response deadline.

End (Expired, Escalate, Resolved) Activities
These activities mark the end of the subprocess with the result of Expired, Escalate or
Resolved.

2.20.4 Escalate Notification Subprocess
The Escalation subprocess initiates when the owner is unable to resolve the service
request and chooses to escalate the service request to the next level of support. In
Oracle Workflow, the Escalation subprocess consists of the following subprocesses
and activities.

Start Activity
This is a standard activity that marks the start of the subprocess.

Select Supervisor Activity
This activity looks for the supervisor of the current service request owner.

Escalate to Supervisor Activity
This activity reassigns the service request to the supervisor of the employee who
escalated the service request.

Update Escalation History Activity
This activity updates the Escalation History. It records the date and time of the new
owner assignment and the escalation comment of the last owner who escalated the
request in the workflow process.
2-48 Oracle Support Concepts and Procedures



Service Request Workflows
Get Request Attributes Activity
This activity updates the workflow attributes with the most current values in the
database.

Set Response Deadline Activity
This activity sets the deadline by which the service request owner must respond to
the notification.

Notify Escalation With Expiration Process
This subprocess consists of the same activities as the Notify Owner With Expiration
subprocess in the Call Support process, except that it sends escalation notifications
rather than assignment notifications to the new owner of the escalated service
request.

Alert Supervisor Process
This subprocess is described below.

End Activity
This activity marks the end of the subprocess.

2.20.5 Alert Supervisor Subprocess
The Alert Supervisor subprocess initiates when the service request owner fails to
respond before the assignment or escalation notification times out. The Alert
Supervisor subprocess consists of the following activities.

Start Activity
This is a standard activity that marks the start of the subprocess.

Select Supervisor Activity
This activity looks for the supervisor of the current service request owner.

Alert Supervisor Activity
This activity notifies the supervisor that the service request owner has failed to take
action before the response deadline.
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End Activity
This activity marks the end of the subprocess.
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3

Using the Service Requests Tools Menu

This section explains how to use the options in the Tools menu to perform
essential business tasks.

The following topics are covered:

� Entering Quality Results

� Sending a Copy of the Service Request Using Fulfillment

� Printing a Service Request

� Copying a Service Request

� Managing Workflows

� Viewing Service Request Audit History

� Creating a Defect from a Service Request

� Creating an Enhancement from a Service Request

� Managing Messages in Service Requests

� Recording Counter Readings

� Billing for Charges from Service Requests

� Escalating a Service Request

� Escalating a Service Request Task

� Navigating Using Quick Menu

Tools Menu options are enabled only when the particular function would
logically be allowed. For example, the Escalate Service Request option is enabled
only after you have created a service request.
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3.1 Entering Quality Results
From a service request, you can directly enter results into a Quality Plan to
collect quality information configured in the Quality Plan.

Prerequisite
You must define a quality plan.

To enter quality results:
1. Navigate to the Service Requests window.

2. Create a service request or query an existing service request.

3. From the Tools menu, select Enter Quality Results option.

For additional information on Quality Plans, refer to Oracle Quality User’s Guide.

3.2 Sending a Copy of the Service Request Using Fulfillment
From within a service request you can send a copy of the service request by
email or fax using the integration with Fulfillment.

Prerequisite
You must set up Oracle 1-to-1 Fulfillment.

To send a copy of the service request using fulfillment:
1. Navigate to the Service Requests window.

2. Create a service request or query an existing service request.

3. From the Tools menu, select the Fulfillment Request option. The Fulfillment
Requests window opens.
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4. From this window, you can select to Email or Fax the fulfillment request.

5. Enter the email address or fax number.

6. Click Submit to send the service request to the fulfillment server.

7. You can open the View tab to see the status of your submission.

3.3 Printing a Service Request
You can print a service request from the Tools menu or from the Print Friendly
Format button in the Log tab or the Workbench tab of the Service Requests
window.
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You can control which note statuses are displayed in the service request
printout.

To print a service request:
1. Navigate to the Service Requests window.

2. Create a service request or query an existing service request.

3. From the second Tools menu, select Print Request.

4. A browser page opens.

5. Select the Note Status(es) that you want to include in the report.

6. Print the service request using your normal browser print functions.

3.4 Copying a Service Request
You can create a new service request by using the Copy Service Request function
to copy the information from an existing service request.

To duplicate a request:
1. Navigate to the Service Requests window.

2. Open a service request or create a new service request.

3. From the Tools menu, select Copy Request. The Copy Service Request
window opens.
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4. Change any of the defaulted Copy To Request information such as Type,
Severity, Owner, Urgency, Customer, Account, Summary. This information
is used to create a new service request.

5. Select the desired Include check boxes to copy additional information into the
new service request.

6. Select one of the following Reference link options; No Link, Create Reference
Link, Create Duplicate Link. If you check Create Reference Link or Duplicate
Link, a Reference link is established, in the new service request only, to the
service request used to create the copy. This Reference link is available in the
Service Request Reference tab.

7. Click Copy. The new service request is created and you are presented with that
service request to enable updates.

3.5 Managing Workflows
Oracle Support uses Oracle Workflow to implement procedures to automatically
notify service personnel about their assignments. From within service requests
you can directly launch and abort workflows. When you launch workflow for a
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service request or a task, a notification is sent to the owner of the service request
or task. The owner can respond to the notification.

Each service request type can be associated with a pre-configured workflow.
When the service request is created, the workflow associated with the service
request type can be configured to start automatically. You can configure an
option to abort the workflow automatically when the service request is closed.
No automatic workflow processing is done if the service request type is
changed.

The Service Request module provides the Active Workflow check box to indicate if
an active workflow is in progress. This check box is located near the bottom of the
service request header. To view the name of the workflow, run a query from the
Define Service Request Type window, using the service request type with which the
workflow is associated as the query criterion.

Prerequisite
You must configure request types to use Oracle Workflow business processes
before you can launch a workflow from a service request.

3.5.1 Manually Using Service Request Workflows
You can manually launch or abort a workflow from within a service request.

To launch a workflow:
1. Navigate to the Service Requests window.

2. Create a service request or query an existing service request.

3. From Tools menu, select the Launch Workflow option.

4. Select Yes to start the workflow

To abort a workflow:
1. Navigate to the Service Requests window.

2. Open a service request or create a new service request.

3. Verify that the Active Workflow check box, in the service request header area, is
checked. Note that you may need to scroll down to view this field.

4. From the Tools menu, select the Abort Workflow option.

5. Select Yes to stop the workflow.
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3.5.2 Using Service Request Task Workflows
After creating or updating a task, you need to notify the task assignees of their
involvement. Workflow emails the task owner and assignee whenever a task is
created or updated.

Prerequisite
You must associate a workflow process to the task type being used.

To enable a workflow for a task:
1. Open the Task tab from the Service Request window.

2. Create or query an existing task.

3. Click More to open the Task Details window.

4. Click Launch Workflow.

5. Save the task.

3.6 Viewing Service Request Audit History
You can view the audit history tracked for changes made to a service request.
The fields audited in the service request are:

� Owner

� Type

� Urgency

� Severity

As you change information about service requests and tasks, the service request
maintains an audit history of the changes. For each audit record, information
such as the user name of the person who made the change, date and time when
the change was made, and the value both before and after the change are
recorded. For example, if you change the status of a service request from Open:
Unassigned to Open: Assigned, the service request records the old and new
status values, as well as the user who made the change and the date of the
change.

To view service request audit history:
1. Navigate to the Service Requests window.
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2. Query an existing service request.

3. From the Tools menu, select Audit History. The Audit History window opens.

4. Enter the duration dates for the audit history information.

5. Select the service request field you want to audit from the list of values in the
Audit field.

6. Review the audit history.

3.7 Creating a Defect from Service Requests
From within service requests you can directly create a defect in the Oracle
Quality Online application. Defects are issues relating to inventory items. Once
the problem reported in the service request has been determined to be a product
defect, use this procedure to create a defect from service requests.
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Prerequisite
The Oracle Quality Online application must be properly configured and setup.
See the Oracle Quality Online Implementation Guide for more information.

To create a defect from service requests:
1. Navigate to the Service Requests window.

2. Create a service request or query an existing service request.

3. From the Tools menu, select Create Defects.

4. The Create Defects HTML page opens from Oracle Quality Online. Your
service request number defaults into the Service Request field.

5. Click Auto Fill to populate the defect create fields. Verify that the Auto Fill
information is correct for this defect. Note that the Summary field on Page 2
displays the summary from the Service Request. You may delete this
summary and create a new summary, if desired.

6. Complete any remaining Product/Platform fields wherever possible.
Although only certain fields may be required based on your setup, your
entries in the other fields affect how the defect is handled and assigned, and
how it will be used for reporting on product quality.

Refer to Oracle Quality Online Concepts and Procedures for additional
information about entering defects.

7. Click Continue after entering all values. The Create Defect page Step 2 of 2
appears.

8. Click Close to return to the service request.

3.8 Creating an Enhancement from Service Requests
From within service requests you can directly create an Enhancement Request.
Enhancements are improvements to existing inventory items.

Enhancements and defects are both tracked and managed in Oracle Quality
Online. Follow the procedure identified in Creating a Defect from Service Requests.
When creating an enhancement, select Enhancement Category from the list of
values.

Refer to Oracle Quality Online Concepts and Procedures for additional
information about entering enhancements.
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3.9 Managing Messages in Service Request
Messages can be sent and viewed from the service request. The Messages feature
leverages Oracle Workflow to send and view messages. For example, you can
send a message for a specific service request from the Service Requests window
that contains a request for action. In this case, a response is required of the
message’s recipient to indicate whether the action is accepted, rejected, or
completed. In addition, you can choose to have a confirmation sent to you once
the recipient has responded to your message.

3.9.1 Sending Messages

Prerequisite
Oracle Workflow must be configured before you can send messages.

To send messages:
1. Navigate to the Service Requests window.

2. Create a service request or query an existing service request.

3. From the Tools menu, select Send Message. The Send Message window opens.

4. Enter the sender’s name in the From field.

You can enter any value, or use the list of values to select from all roles defined
for use with Oracle Workflow. The default value is the Workflow display name
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of the current user; if the user’s Workflow role cannot be determined, the FND
user name defaults.

5. Select a Priority from the list of values.Three priorities are provided with the
Message feature (High, Medium, Low) and Medium is the default value.
These Priorities are not user definable and are not related to Oracle
Workflow notification priorities.

6. Select an Action from the list of values.

For more information, see Defining Action Requests in the Oracle Support
Implementation Guide.

7. Enter the recipient’s name in the To field. Note that the recipient’s name must
be defined in Oracle Workflow roles.

8. Check Expand Roles if you plan to send this message to a Workflow role that
includes several individuals and if you want each person to receive a copy of
the message.

� By default (if this box is not checked), one message is sent to the role as a
whole. If one individual responds to or closes the message, the message
is removed from the inbox of all other individuals in that role.

� If you check Confirmation, you will not be able to check Expand Roles.

� If you entered an Action, you will not be able to check Expand Roles.
The reason for disabling the Expand Roles function is because you may
not want all of the recipients to perform the same action.

9. Optionally, check Confirmation if you want to receive a confirmation message
once the recipient has responded to your message.

� If you check Confirmation, the From field is validated to ensure that the
sender is a valid Workflow role.

� If you check Expand Roles, you will not be able to check Confirmation.

10. Enter your message text.

11. Click Send to pass the message to Oracle Workflow for delivery and processing.

3.9.2 Viewing and Responding to Messages
These messages will also appear in the Universal Work Queue along with other
Oracle Workflow notifications. They may also appear in your email application,
a Web page or Oracle Workflow Notification Summary window, based upon
your Oracle Workflow configuration.
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To view and respond to messages:
1. Navigate to the Universal Work Queue.

2. Select a message and open it by double clicking on the message. The
Notifications window appears.

3. Select Respond and choose your response from the Result list.

If the message does not include an action request, you must respond with
Acknowledge. Otherwise, choose one of the following responses:

� Accept if you accept the responsibility of performing the requested
action.

� Reject if you reject the responsibility of performing the requested action.

� Done if you have completed the action.

4. Optionally enter additional comments, such as your reason for rejecting the
request.

5. Select OK. A confirmation message will be sent to the original message’s
sender if and only if the sender checked Confirmation.

3.9.3 Viewing Message History

To view message history for a service request:
1. Navigate to the Service Request window.

2. Open a service request.

3. From the Tools menu, select View Message.

The Message History window appears, displaying sender, recipient, and response
information for all messages that were sent concerning the service request.
3-12 Oracle Support Concepts and Procedures



Recording Counter Readings
3.10 Recording Counter Readings
From within service requests you can update any Counters associated with a
specified product, installed base item or product. An example of a usage for
counters is a service contract for a copy machine where the contract charges
depend on the number of copies that have been generated.

Prerequisite
A service request for a product or installed base that has a counter defined and
instantiated must be available. See the Oracle Service Implementation Guide for
more information.

To record counter readings from service requests:
1. Navigate to the Service Requests window.

2. Create a service request or query an existing service request.

3. From the Tools menu, select Counter Capture. The Counter Capture window
opens.
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4. Enter the New counter value, miscellaneous reading information or reset the
counter.

5. Click Save.

3.11 Billing for Charges from Service Requests
Using the charges capability, a service organization can bill customers for
services provided for services, repairs and returns.

To bill for charges:
1. Navigate to the Service Requests window.

2. Create a service request or query an existing service request.

3. Open the Charges window by selecting the Charges option from the Tools
menu.

Request details such as Type, Status, Severity, and Date come from the parent
service request. The Bill To and Ship To addresses default from the service
request. These addresses can be changed.

Refer to Oracle Service Concepts and Procedures for additional information about
entering charges.

3.12 Escalating a Service Request
Using the escalation functionality, you can create an escalation document for
critical situations involving one or more service requests. The escalation
document raises awareness and enables swift action to manage and resolve the
situation. The escalation document is assigned to an owner, and tracks the
business situation information, requester, additional contacts, and all actions
taken toward resolving the situation. The escalation document can also identify
or escalate related service requests, defects and tasks as required.

The current escalation level of a service request is displayed in the Escalation
Level field on the Service Request window. Escalation levels represent the
degree of visibility. The default value of Not Escalated is associated with all
service requests that have not been escalated.

You must scroll down on the header region of this window to view this field.
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A system profile option is available for setting the color of the service request
number when the service request is escalated. See the Oracle Support
Implementation Guide for more information on using this profile option.

Notifications are an integral part of the escalation functionality. Oracle
Workflow is used to process and deliver the notifications regarding escalation
activity. Notifications are sent for the following reasons:

� Escalation creation

� Escalation status changes

� Escalation owner assignment and changes

� Escalation level changes

Notifications can be sent to a variety of recipients, depending on the system
profile options set. Typical recipients include:

� Owner of the service request

� HR manager of the service request owner

� Escalation Territory member or the Primary Contact

To escalate a service request:
1. Navigate to the Service Requests window

2. Create a service request or query an existing service request.

3. From the Tools menu, select Request Escalation. The Escalations window opens.
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4. The customer and service request information defaults.

5. Select a status code that fits the status of the escalation.

6. Select a reason code that describes the reason for the escalation.

7. Date Opened is automatically populated when the window is opened.

8. Date Closed is automatically populated when the escalation is closed.

9. Optionally enter a Target Date for closing the escalation.

10. Select the Escalation Level from the list of values.

11. The Escalation Owner is the party responsible for managing the escalation.
Assign the escalation to a resource using one of these two methods:

� Select a resource from the list of values.

� Click Assign to select an escalation owner using the Assignment
Manager. Click Search. Select a resource by double-clicking on the
resource name and then click OK.

12. Enter a situation summary in the Escalation Summary field.
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13. In the Contacts tab, enter the customer or employee contact who is requesting
the escalation and check the Requester box.

14. Optionally enter additional contact points.

15. Optionally add more reference documents to the escalation.

16. Optionally click Notes to create a note about the escalation.

17. Optionally click Tasks to create a task related to managing the escalation

18. Click Save to assign an escalation number. Notifications are sent based upon
the escalation management setup and system profile options.

For additional information regarding Escalation Management, see the Oracle
CRM Foundation Concepts and Procedures.

3.13 Escalating a Service Request Task
Using the escalation functionality you can create an escalation document for
critical situations involving one or more tasks in a service request. The escalation
document raises awareness and enables swift action to manage and resolve the
situation. The escalation document is assigned to an owner, tracks the business
situation information, requester, additional contacts, and all actions taken
toward resolving the situation. The escalation document can also identify or
escalate related service requests, defects and tasks, as required.

To escalate a service request task:
1. Navigate to the Service Requests window

2. Create a service request or query an existing service request.

3. Open the Task tab.

4. Select the task to escalate.

5. From the Tools menu, select Task Escalation. The Escalations window opens.

6. The customer and service request information defaults.

7. Select a status code that fits the status of the escalation.

8. Select a reason code that describes the reason for the escalation.

9. Date Opened is automatically populated when the window is opened.

10. Date Closed is automatically populated when the escalation is closed.
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11. Optionally enter a Target Date for closing the escalation.

12. Select the Escalation Level from the list of values.

13. The Escalation Owner is the party responsible for managing the escalation.
Assign the escalation to a resource using one of these two methods:

14. Select a resource from the list of values.

15. Click Assign to choose an escalation owner using the Assignment Manager.
Click Search. Select a resource by double-clicking on the resource name and
then click OK.

16. Enter a situation summary in the Escalation Summary field.

17. In the Contacts tab, enter the customer or employee contact who is
requesting the escalation and check the Requester box.

18. Optionally enter additional contact points.

19. Optionally add more reference documents to the escalation.

20. Optionally click Notes to create a note about the escalation.

21. Optionally click Tasks to create additional tasks related to managing the
escalation

3.14 Navigating Using Quick Menu
The Quick Menu enables you to easily navigate to other windows because the
search criteria from the Service Request is automatically used when the new
form is opened. For example, to view or update information about your
customer’s products from an existing service request, select View Customer
Products from the Quick Menu. The Product Summary and Details window
opens defaulting in your product information from your service request.

Quick menu helps you store search criteria in windows from which the search
functionality is available. Using quick menu, you can store frequently used
criteria and open up windows more quickly than by manually entering the
search criteria and then searching for records.

For Quick Menu to function properly, save your folder the first time you access
the Quick Menu. Click Save As and enter the appropriate folder name and save
your changes. After you save your folder, select your folder name the next time
you use Quick Menu. To navigate to one of the functions, double-click on the
function name.
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If you do not need to use some of the form functions available from the quick
menu, you can remove it from the Quick Menu menu at the responsibility level.
See Oracle Customer Care Implementation Guide for more information.

You can add additional form functions to the Quick Menu, even though the
form function is not quick menu enabled. This allows you to quickly navigate to
the form, but the variables in the original form are not passed to the form on the
quick menu. Only quick menu enabled forms can accept variables from the
original form.

To access the quick menu:
1. Navigate to the Service Requests window.

2. Create a new service request or query an existing service request.

3. From the Tools menu, select Quick Menu, The Quick Menu window opens.
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4. Double-click the desired menu option. A new window opens and defaults in
specific information from your service request. The menu options available
from the Quick Menu are:

� Manage Critical Customer

� Maintain Relationship Plans

� Create Fulfillment Request]

� Order Capture

� Search Knowledge Base

� View Customer Product
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� Maintain Systems

� Contact Center

� Service Request

� Depot Repair
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